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ENTRY AND REGISTRATION ~ ALL CATEGORIES

Regardless of whether you are entering digital or print entries all entrants must submit the following.

Ensure your digital file represents the finished appearance you wish judges to view. For an image where you would have 
used a circular, oval or polygonal mat if you had been printing your entry, apply an overlay mask in Photoshop. This ensures 
the audience and judges view your intended format, and awarded images are represented correctly in all NZIPP and 
sponsor material.

DIGITAL IMAGE UPLOAD FILE SPECIFICATIONS

For all entries, your uploaded digital file must be:

Dimensions: 25.4cm on the longest side

Resolution: 300 dpi (3000 pixels)

Colour Mode: RGB colour mode (not Grayscale)

Bit Depth: 8 bits/Channel

JPEG Quality: 8

Colour Profile: sRGB 

JPEG Format: Baseline ("Standard")

DIGITAL FILE NAMING 

The Digital File Name you enter must be the same as the name used for your uploaded digital file.

Use the following file naming convention for both: Category Code_PRINT or DIGI_Surname_First Name_Entry Number

It is important that your file names reflect whether your entry is for print awards, or digital awards. Use the code PRINT as 
above for print award entries, and DIGI for digital entries.

Eg. CR_PRINT_Bloggs_Joe_01

Your Surname and First Name must be in Sentence Case (not Caps).

Your first entry in each category should be numbered 01, for example:

TV_PRINT_Bloggs_Joe_01	  	

TV_DIGI_Bloggs_Joe_02

TV_DIGI_Bloggs_Joe_03 	  	

TV_PRINT_Bloggs_Joe_04

CATEGORY CODES
CM - Commercial			   CR - Creative			   DC - Documentary 

EX - Expressive 				    FA - Family 			   IL - Illustrative 

LI - Landscape In-Camera		                LO - Landscape Open		  NA - Nature	

PI - Portrait In-Camera 			   PO - Portrait Open		  ST - Student 

TV - Travel				    WI - Wedding In-Camera		  WO - Wedding Open

USB FILE PREPARATION
As part of the vetting process, the Honours Council requires you to send a USB containing:

	» All 'original capture' (RAW, DNG, or unedited JPEG) files for each and every element used within each entry 
submitted; 

	» The final image file for each entry. This is the same flattened JPEG file you will upload as part of your online entry 
registration.

File management:
	» Create a single main folder with your name and entrant/member ID number. E.g, Brown_Jenny_1234;
	» Inside the main folder, create a separate folder for each image entered, naming it with a short image title that 

allows for quick identification of each entry.
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IMAGE SETTINGS  

IMAGE MODE

Image > Mode:

	» RGB colour mode (not Grayscale)

	» 8 bits/Channel

IMAGE SIZE

ASSIGN PROFILE

Image > Image Size:

	» 25.4 cm on the longest side

	» 300 dpi (3000 pixels)

Edit > Assign Profile:

	» sRGB
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File > Save As > JPEG:

	» Quality:  8 (High)

	» Baseline ("Standard")

IMAGE SETTINGS - LIGHTROOM

JPEG Export:

	» Quality:  80

	» Colour Space: sRGB

	» Image Size:  25.4 cm on the longest side

	» Resolution:  300 (pixels per inch)

IMAGE SETTINGS  
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	» Creator:      Your name

	» Headline:    Nature Category only - Scientific  	
                     or Common Name (refer to  	
                     page 10)

	» Description: Category entered

	» Description: Caption for Nature and  	
                      Expressive categories only.

	» Author:        Your name

	» Author Title: Nature Category only -  	                          	
 Scientific or Common Name (refer to page 
10)

	» Description:  Category entered

	» Description:  Optional caption for Nature 
and Expressive categories only.

IMAGE SETTINGS  



IRIS AWARDS CALL FOR ENTRIES 2021 29

FOR BOTH DIGITAL AND PRINT ENTRIES:
Once your files are renamed and ready for uploading go to: https://nzipp.awardsplatform.com/  

Register if you are a first-time user, or login and enter. 

Download and save your print entry PDF documents (see Page 34).

FOR DIGITAL ENTRIES ONCE YOU HAVE COMPLETED ONLINE ENTRY
	� You must post a USB with all original capture (RAW, DNG or unedited JPEG) files for each and every 

element used within each entry submitted as well as the final image file for each entry, which is the 
same flattened JPEG file you upload as your online entry registration. 

	� If you would like your USB returned, you need to include prepaid, self-addressed return packaging 
unless you have also sent prints, in which case your USB will be returned with your prints.

	� From 10 July 2021, you can send your USB to: Nikon Iris Awards, c/- 210 Hill St, Richmond 7020, Nelson. 
Prints must be received by Friday 23 July 2021 to be eligible for entry. 
 

 
FOR PRINT ENTRIES ONCE YOU HAVE COMPLETED ONLINE ENTRY

	� Print all documents you downloaded and saved;

	� When printing the PDF documents from your online entry, do not reduce these in size. Also make sure 
that your printed label is clear and black, not faded grey;

	� Attach the PDF document to the top left on the back of each respective print. Make sure you get this 
right because this is how they will be presented to the judges;

	� You can put a big "Up" Arrow on the back for print orientation, using a permanent marker;

	� You must post a USB with all original capture (RAW, DNG or unedited JPEG) files for each and every 
element used within each entry submitted as well as the final image file for each entry, which is the 
same flattened JPEG file you upload as your online entry registration. USBs will be returned in your print 
cases;

	� Include a return address label so we can return your prints;

	� Package your prints using one of the packaging options listed on page 35;

	� From 10 July 2021, you can send your prints to: Nikon Iris Awards, c/- 210 Hill St, Richmond 7020, Nelson. 
Prints must be received by Friday 23 July 2021 to be eligible for entry.

 

HOW TO ENTER FOR PRINT OR DIGITAL
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PREPARING PRINT ENTRIES

MINIMUM IMAGE SIZE
The visible portion of an image, inside any matting, must be no smaller than 25cm on the longest side. One side 
of the image must be at least 25cm. The only exceptions to this are:

	» When entering polaroid, tin type or glass plate originals;

	» The Expressive Category.

IMAGES WITH MATTED OVERLAYS

Visible portion of the
longest side

25cm minimum

Visible portion of the
longest side

25cm minimum

	» Print images so the longest side is greater than 25cm e.g. print at 26cm so that you have some image to 
tuck behind the mat;

	» Provide your matter with clear instructions about the minimum visible image size.

Visible portion of the
longest side

Minimum 25cm

25cm minimum

Image on the
longest side

Visible portion of the
longest side

Minimum 25cm

25cm minimum

Image on the
longest side
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SQUARE & CIRCLE IMAGES
	» The width or diameter of the visible portion of the image must be no smaller than 25cm.

MULTIPLE IMAGES (SERIES)
For an entry made up of two or more images on a single mount:

	» The height of at least one image must be at least 25cm; or, 

	» The combined width of all images, the visible portion only, must be at least 25cm. This excludes the 
spacing between the images.

Diameter of the image

25cm minimum25cm minimum

Visible portion of the
longest side

Combined widths of A + B + C must 
be no less than 25cm and excludes 

spaces between images

B CA

Height of A, B, and/or C must 
be no less than 25cm

CA B

PREPARING PRINT ENTRIES
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MOUNTING YOUR PRINTS 
The presentation of entries in the Iris Awards must be of a professional standard. They also need to be lightweight 
and of a uniform size for ease of handling and display.

For all print entries, excluding the Expressive Category:

	» These must be flush- or window-mounted onto a 3mm or 5mm foam core backing board; total thickness 
must be between 3-7mm;

	» The mat board and backing board dimensions must be 50cm x 40cm;

	» The prints can be mounted using either a vertical or horizontal orientation;

	» The largest size a print can be is 50cm x 40cm;

	» Prints must be mounted in such a way they will not damage other prints or require special handling - no 
part is to protrude above the surface level of the mat board.

PREPARING YOUR PRINT ENTRIES

50
c

m

40cm

50cm

40
c

m

 LIGHTING
It is recommended when printing that you view and check your prints under similar lighting conditions to those 
at print judging. The judges' lighting will be tested with a light meter set at 100ISO with the reading taken from 
the centre point of the print and the light meter pointing toward the viewing position of the judges.

The exposure reading will be 1/30th of a second at f2.8. The ambient room lighting will be approximately 2 stops 
less.
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PREPARING EXPRESSIVE ENTRIES

ENTRY SIZE
Expressive entries must be a physical entry. Apart from that, there are no specific requirements on the 
presentation format of entries in the Expressive Category, as long as the entry is not so big that it can't be 
handled by one person. The content and/or presentation of an entry must not place any person at risk of harm 
in its handling.

PREPARING YOUR ENTRIES
Not all entries in the Expressive Category will be mounted. The method of presentation should best fit the nature 
of the work being presented and fall within the specifications outlined in the category criteria.

As part of the online entry registration process;

	» Upload a JPEG version of the 'artwork', or, in the case of a book an image that is representative of the 
book (this could be the cover or an image of a specific page). Refer to the specifications shown on the 
'Digital Image Upload Size' (page 25).

SENDING YOUR ENTRIES
Entries into the Expressive Category may not fit into a standard sized print case. Package your entries in a sturdy, 
returnable box or packaging. Include in the box or packaging:

	� The PDF document from your online entry (if it is not possible to attach this to the entry itself - see page 34 
for PDF Identity Label information);

	� USB; containing all original capture (RAW, DNG or unedited JPEG) files for each and every element used 
within each entry submitted as well as the final image file for each entry, which is the same flattened JPEG 
file you upload as your online entry registration;

	� Return address label;

	� Return pre-paid courier ticket(s). You must use New Zealand Couriers for this service. We are unable to 
return entries without a supplied courier ticket.

Please note, the Honours Council takes no responsibility for any damage done to entries in the process of 
handling, judging and/or display.
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PDF IDENTITY LABELS
PDF documents are generated on completion of your online entry registration. Save these documents to your 
computer. Once you have made payment and submitted your entry, you'll see the PDF icon to the right of your 
entry. Click on this to download to your computer.

PDFs: 
	 - These are two page documents. Please ensure both pages are attached to the back of the print. You    	
       can cut the bottom off of Page 2, and stick page 1 with the image printout from Page 2 to the back. 
	 - They must be clear and black to ensure they can be read by the scanners.

	» Attach the PDF print-out to the top left on the back of each respective print.

	» Write the word 'TOP', or add an arrow, to show the correct viewing orientation.

	» Remove residue glue, adhesive tape, velcro, etc, from the back of mounted work, to prevent damage 
to your own prints or to the work of others.

PRINT LABELS & PACKAGING

PACKING YOUR PRINTS
When packing your prints:

	» Interleaf your prints with a sheet of tissue paper, or similar, to protect the print surface. There is no need 
to 'wrap' and secure each individual print. This creates excess rubbish.

Include with your entries: 
	

	� USB; containing all original capture (RAW, DNG or unedited JPEG) files for each and every element 
used within each entry submitted as well as the final image file for each entry, which is the same 
flattened JPEG file you upload as your online entry registration.

	� Return address label. 
	

TOP TOP



IRIS AWARDS CALL FOR ENTRIES 2021 35

PACKAGING OPTIONS

INDIVIDUAL ENTRANTS (INCLUDING INDIVIDUAL STUDENT ENTRIES)
Entering the Nikon Iris Awards can be a big financial commitment, so this year we are trialling two options for the 
submission and return of standard print entries:

1.	 Print case (rigid plastic)

2.	 Print box (cardboard)

If you already own one, a print case is still the preferred option to better protect your prints and for handling 
logistics. However, print cases are no longer available from our supplier, so if you don't have one, we recommend 
you order a print box. The print boxes are cheaper which may be particularly helpful for those who are dipping 
their toes into the Iris Awards waters for the first time. 

Please note, no two entrants can share a print case or print box, even if from the same studio. The only exception 
is Student entries. See the bottom of this page for more details.

Print box - this is a sturdy cardboard box (520mm L x 440mm W x 75mm D) and will fit up to 10 matted prints. 
A print box costs $12 plus p&h and may last a year or two.

	» Order your print box well in advance by contacting Sean at sean@evokestudio.co.nz;

	» The print box will be sent direct to you so you can use it for sending in your entries;

	» Tape the print box carefully so it doesn't come open in transit;

	» Firmly attach a sheet of acetate (one side of a clear acetate L-pocket is great for this) to the box. Insert 
your address label into this. Adding a velcro dot at the open edge of the pocket will prevent the label 
falling out.

	» Your entries will be returned in the same print box.

STUDENT ENTRIES ONLY
Individual students from the same institution can share a print case or sturdy returnable box.

The handling fee covers the return cost of ONE standard size print case (or similar sized box). When sending in 
large boxes, or or extra boxes or cases, you must include a pre-paid return 'New Zealand Courier' ticket to cover 
the extra boxes or cases. Should extra boxes/cases arrive without return courier ticket(s) they are unable to be 
sent back.
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SENDING YOUR PRINT OR EXPRESSIVE ENTRIES

To avoid delays, worry, and disappointment:

	» Send your entries well in advance of the print delivery deadline!

	» Track your entries!

INTERNATIONAL ENTRANTS
Print cases need to pass through NZ Customs. To make the process smooth, and to minimise the risk of additional 
fees and taxes:

	» Mark your Customs Declaration form with the following: 
Entries into the Nikon Iris Awards 
Delivery deadline 4.00pm (NZST), FRIDAY 23rd JULY 2021 
Items returned to sender after judging

	» Limit the monetary value of the goods to no more than $150.00;

	» Track your print case progress to the delivery address on the label.

NZIPP will not be responsible for paying any import duties or GST for entries. Nor will NZIPP take responsibility for 
coordinating the release of an entrant’s work from Customs or their agent.

Entries must be accompanied with pre-paid, return address packaging and any international documentation 
that may be required if you want the entry returned. We suggest using the courier companies DHL or TNT to 
send your prints.

DELIVERY CONCERNS
If your print case has not arrived by the delivery deadline of Friday 23rd July 2021, notify us immediately at 
irisawards@nzipp.org.nz.

SEND ENTRIES AND USBS TO:

Nikon Iris Awards
c/- 210 Hill Street
Richmond 7020
NELSON

mailto:irisawards@nzipp.org.nz

